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Računarsko modelovanje

CILJEVI

Cilj ovog poglavlja je dvojak. Prvo, ono treba da pruži pregled načina računarskog mode-
lovanja i drugo, treba da vam predstavi program Mechanical Desktop 2005 i upozna vas s 
njegovim korisničkim okruženjem. U ovom poglavlju upoznaćete ključne funkcije programa 
Mechanical Desktop 2005: parametarsko modelovanje punih tela zasnovano na konstruisanju 
njegovih elemenata, modelovanje sklopova, površinsko modelovanje i tehničko crtanje. 
Kada proučite ovo poglavlje, moći ćete da:

• opišete tri vrste računarskih modela;
• opišete glavne funkcije programa Mechanical Desktop;
• navedete glavne korake u konstruisanju parametarskih punih delova,  

sklopite pune delove i izradite odgovarajuće tehničke crteže;
• objasnite kako se koriste NURBS površine pri modelovanju tela proiz-

voljnog oblika

PREGLED
Za precizno prikazivanje projekta u industrijskom i inženjerskom projektovanju oduvek 
su se koristili modeli. Danas izrada trodimenzionalnih (3D) modela pomoću računara 
nudi više prednosti. Prvo, takvi modeli znatno olakšavaju naknadni proces kompjuter-
izovane proizvodnje delova. Drugo, pomoću virtuelnih sklopova modela možete da 
predstavite čitave proizvode ili sisteme. Na kraju, od 3D modela i virtuelnih sklopova 
možete da izradite klasične dvodimenzionalne (2D) tehničke crteže.

Program Mechanical Desktop 2005 izveden je iz AutoCAD-a 2005 i koristi isti for-
mat datoteka (DWG). Osim osnovnih računarskih funkcija za projektovanje koje ima 
i AutoCAD, Mechanical Desktop ima i četiri skupa alatki za projektovanje (tj. modu-
la) koji služe konstruisanju 3D modela, 3D površina, pravljenju sklopova i podsklopo-
va punih 3D modela, i pravljenju tehničke dokumentacije 3D tela, sklopova i površina.  
U alatke za projektovanje spadaju: modul za parametarsko modelovanje punih tela, mo-
dul za modelovanje sklopova, modul za površinsko modelovanje i modul za tehničko 
crtanje. Korisničko okruženje veoma liči na okruženje AutoCAD-a, ali Mechanical 
Desktop ima i pretraživač objekata (engl. object browser) koji omogućava da lako sagle-
date i hijerarhijski organizujete objekte u različitim prikazima i crtežima modela.
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KONCEPTI MODELOVANJA
Modeli su korisni u različitim fazama projektovanja proizvoda ili sistema jer omogućavaju da 
se proizvod ili sistem analiziraju i da se bolje sagleda njihova fizička priroda. Često se u tom 
cilju pred sam kraj projektovanja pravi maketa (engl. mock-up) modela. Međutim, pravljenje 
makete je skupo, a gotovu maketu je teško naknadno menjati. Zbog toga je velika prednost 
računarskog modelovanja to što vam omogućava da napravite model koji se može podesiti i 
izmeniti mnogo lakše od njegovog fizičkog parnjaka.

PREDSTAVLJANJE 3D OBJEKATA NA RAČUNARU
Pre nego što napravite računarski model, morate pažljivo razmotriti različite osobine objekta 
ili objekata koje model treba da predstavlja. Među njima su: geometrija objekta (oblik, profil i 
silueta), spoljni izgled (boja, tekstura) i svojstva (masa, težište i druga fizička svojstva).  U ovoj 
knjizi konstruisaćemo virtuelne modele 3D objekata držeći se uglavnom računarski konstru-
isanih digitalnih modela da bismo predstavili geometriju različitih proizvoda i sistema.

KLASIČAN 2D PRISTUP PROJEKTOVANJU
Klasičan pristup, po kome se 3D objekat predstavlja pomoću njegove tri ortogonalne 2D pro-
jekcije, ima više nedostataka. Prvo, on zahteva temeljno poznavanje nacrtne geometrije. Drugo, 
3D objekat proizvoljnog oblika teško se s dovoljnom tačnošću predstavlja pomoću njegove 
tri 2D projekcije. Slika 1-1 prikazuje tehnički crtež sa tri 2D projekcije automobilske školjke. 
Pošto siluete i profili nisu jasno prikazani, na crtežu nema dovoljno podataka potrebnih za 
proizvodnju školjke.

Slika 1-1 Tehnički crtež objekta proizvoljnog oblika

3D MODELI
U osnovi postoje tri vrste računarskih 3D modela: žičani (engl. wireframe), površinski (engl. 
surface) i puni (engl. solid) model. Razlike među njima mogu se ilustrovati na modelu pravo-
ugaone kutije. Žičani model kutije sastoji se od 12 pravolinijskih segmenata. Njen površinski 
model sadrži šest površina. Puni model kutije predstavlja jedinstven, pun objekat (koji ima 
zapreminu).
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ŽIČANI MODELI
Žičani modeli se na računaru prave najjednostavnije. Žičani model predstavlja 3D objekat 
pomoću skupa međusobno nepovezanih krivih koje čine ivice 3D objekta. Model je samo ble-
da senka 3D objekta – krive nisu ni u kakvom međusobnom odnosu. Shodno tome, žičani mo-
del ne sadrži nikakve informacije o površinama ili zapremini – samo o ivicama i temenima. Vi 
treba da međusobno povežete krive da biste mogli da zamislite površinu i zapreminu objekta. 
Na slici 1-2 prikazan je žičani model objekta proizvoljnog oblika. Na njoj se vide samo ivice na 
kojima se susreću površine, ali samih površina nema u modelu. Pošto nema podataka o površini 
i zapremini objekta, a „žice“ su bez debljine, model ne možete da prikažete realistično.

Slika 1-2 Žičani model objekta proizvoljnog oblika

Ponekada žičani model izaziva nedoumice. Jednostavna kockasta kutija na slici 1-3 prika-
zana je levo kao žičani model, dok je desno nekoliko mogućih 3D objekata koje možete iz-
vesti iz tog modela.

ŽIÅANI MODEL MOGUÑI 3D OBJEKTI

Slika 1-3 Zbunjujući žičani model

Žičani model ima ograničenu primenu u proizvodnji delova. Takvi modeli se koriste za 2-1/2D 
CNC mašine i 2D profilisanje. Pomoću žičanog modela ne možete da procenite masena svojstva 
objekta, da otkrijete neslaganje sastavnih delova niti da izvedete druge važne analize.
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POVRŠINSKI MODELI
Površinski 3D model je skup 3D površina koje se u 3D prostoru spajaju u objekat. U poređenju 
sa žičanim 3D modelom, površinski 3D model – osim podataka o ivicama – sadrži i infor-
macije o konturama i siluetama površina. Površinske 3D modele možete da upotebite u 
kompjuterizovanom sistemu proizvodnje, za realistično prikazivanje modela i za animaci-
je. Pošto površinski model predstavlja skup površina, za njegovo pravljenje potrebno je kon-
struisati pojedinačne površine. One se najlakše konstruišu ako nacrtate skup krivih od kojih 
računar automatski stvara površinu. Na slici 1-4 prikazan je skup krivih zajedno s površinom 
konstruisanom od njih.

Slika 1-4 Krive i površina konstruisana od njih

Površinski model možete da sastavite od skupa pojedinačnih površina. Na slici 1-5 prika-
zan je površinski model s rasklopljenim površinama (engl. exploded surfaces). Na slici 1-6 dat 
je realističan prikaz površinskog modela.

Slika 1-5 Površinski model s rasklopljenim površinama
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Slika 1-6 Realističan prikaz površinskog modela

PUNI MODELI
Puni 3D modeli (engl. 3D solid models) sadrže najviše podataka o objektu. Oni obuhvataju 
integrisane matematičke podatke o površinama, ivicama i zapremini objekta. Osim za vizu-
elizovanje i proizvodnju, podatke koje sadrži pun model možete da iskoristite i za projektne 
proračune. Na slici 1-7 prikazan je pun model cilindričnog zupčanika.

Slika 1-7 Pun model cilindričnog zupčanika

Pošto su 3D objekti jedinstvenog oblika, integrisani podaci potrebni za prikazivanje pu-
nog tela složeniji su nego oni za prikazivanje površinskog ili žičanog modela. Puni modeli se 
konstruišu najčešće od skupa krivih koje se zatim transformišu pomoću četiri osnovne metode: 
izvlačenjem (engl. extrude), obrtanjem (engl. revolve), složenim izvlačenjem duž putanje (engl. 
loft) i prostim izvlačenjem duž putanje (engl. sweep) (slike 1-8 i 1-9).
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IZVLAÅEÇE
(EXTRUDE)

OBRTANJE
(REVOLVE)

SLOÆENO 
IZVLAÅEÇE DUÆ 
PUTAÇE (LOFT)

PROSTO IZVLAÅEÇE
DUÆ PUTAÇE (SWEEP)

Slika 1-8 Četiri osnovna postupka s krivom

Slika 1-9 Realističan prikaz izvučenog tela, obrtnog tela, tela izvučenog metodom loft i tela izvučenog 
metodom sweep

U osnovi, složena puna tela konstruišu se tako što se prvo naprave osnovni oblici punih tela 
koji se zatim kombinuju logičkim (Bulovim) operacijama. Na primer, cilindrični zupčanik sa 
slike 1-7 predstavlja kombinaciju dobijenu izvlačenjem i obrtanjem. Telo zupčanika dobijeno 
je obrtanjem, a svaki zubac je naknadno dobijen izvlačenjem (slika 1-10).

Slika 1-10 Izvučeno puno telo (zubac) usečeno u obrtno puno telo (telo zupčanika)

IZBOR MODELA
Žičani model predstavlja samo ivice i temena 3D objekta. Zbog nedostatka informacija o 
površini i zapremini objekta, on ima vrlo ograničenu primenu u proizvodnji. Osim ivica i te-
mena, površinski model sadrži površine i siluete 3D objekta. Kada uporedimo površinski i pun 
model, treba reći da se pun model lakše konstruiše. Međutim, on nepotpuno prikazuje složene 
objekte proizvoljnog oblika. Za predstavljanje 3D objekata koji imaju složene profile i siluete, 
neophodan je površinski model.

Sve u svemu, puni 3D modeli pogodniji su za konstruisanje 3D objekata pravilnih geomet-
rijskih oblika, dok su površinski 3D modeli prevashodno namenjeni konstruisanju 3D ob-
jekata proizvoljnog oblika. (Ako imate površinski model sastavljen od skupa površina koje 
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„hermetički“ obuhvataju određenu zapreminu, možete ga pretvoriti u pun model.) Iako se 
3D krive ne koriste za konstruisanje žičanih 3D modela, možete ih iskoristiti kao podlogu za 
pravljenje 3D površina i punih 3D tela.

METODE MODELOVANJA
Kada želite da konstruišete računarski 3D model, osmotrite objekat u celini i razmislite o 
tome kako da ga razbijete na jednostavnije elemente. Zatim konstruišite osnovne elemente i 
spojite ih u 3D model. Elementi na koje ćete rastaviti objekat zavise od vrste 3D modela koji 
želite da konstruišete.

Za konstruisanje žičanog modela, razmišljajte o ivicama na kojima se susreću dve strane 
3D modela. Ne zaboravite ni podrazumevane ivice na mestima gde površine prelaze u svoje 
tangentne ravni. Konstruisanje žičanog modela je mukotrpan posao jer morate da unosite 3D 
koordinate da biste definisali žice. Da biste konstruisali jednostavnu kocku, treba da definišete 
12 pravih u 3D prostoru. Kada su ivice zakrivljene, posao je još složeniji.

Kod površinskog modela razmišljajte najpre kako da 3D objekat razbijete na pojedinačne 
površine. Zatim napravite površine tako što ćete konstruisati skupove krivih koje će računar 
automatski povezati u površine. Površina se generiše gotovo automatski, ali je konstruisanje 
skupa krivih složeno.

Kada želite pun model, rastavite 3D objekat na jednostavne pune elemente, konstruišite 
elemente i sklopite ih u 3D objekat. Ako koristite parametarski postupak (koji objašnjavamo 
kasnije u poglavlju), modelovanje punog objekta mnogo je lakše od površinskog modelovanja 
ili pravljenja žičanog modela.

MODELOVANJE SKLOPA
Proizvod ili sistem obično ima više komponenata (tj. sastavnih delova). Modeli sklopova se 
prave tako što se više komponenata uključuje u jedinstvenu datoteku sklopa (engl. assembly 
file). Pošto definicije 3D modela već postoje u datotekama pojedinačnih komponenata, datote-
ka sklopa samo opisuje način sklapanja komponenata i njihove geometrijske odnose. Na slici 
1-11 prikazan je sklop dečjeg automobila.

Slika 1-11 Sklop dečjeg automobila
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TEHNIČKO CRTANJE
Iako se u većini savremenih fabrika koriste računarski modeli, ponekad treba odgovoriti na 
specijalne zahteve i izraditi tehničke 2D crteže. Konstruisanje ortogonalnih 2D projekcija na 
osnovu računarskog 3D modela izvodi se veoma lako: samo zadate prikaze (engl. views) i nji-
hovu poziciju, a program ostalo radi sam. Crteži se zatim upotpunjavaju oznakama (engl. an-
notations). Na slici 1-12 prikazan je tehnički crtež izrađen na osnovu modela sklopa dečjeg 
automobila.

Slika 1-12 Tehnički crtež

RAD S PROGRAMOM MECHANICAL DESKTOP
Mechanical Desktop 2005 je alatka za industrijsko i inženjersko 3D projektovanje, integrisana 
u AutoCAD 2005. Mechanical Desktop koristi format datoteka s crtežima (DWG) svojstven 
AutoCAD-u i proširuje mogućnosti tog programa pomoću četiri glavne funkcije:

• Parametarsko modelovanje punih tela (engl. parametric solid modeling)

• Modelovanje sklopova (engl. assembly modeling)

• Površinsko modelovanje (engl. surface modeling)

• Tehničko crtanje (engl. engineering drafting)

TIPOVI DATOTEKA
Iako je Mechanical Desktop nadogradnja AutoCAD-a 2005, on ima dve jasno razgraničene 
vrste datoteka: datoteke delova (engl. part files) i datoteke sklopova (engl. assembly files). Datoteke 
delova se koriste za pravljenje punih delova, dok datoteke sklopova služe za konstruisanje 
sklopova. Iako za pravljenje površina možete upotrebiti i jedan i drugi tip datoteka, zbog do-
slednosti bi trebalo da za to koristite datoteke delova.
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Datoteke delova
Kao u AutoCAD-u, datoteka delova ima dva radna okruženja: okruženje za modelovanje (Mod-
el) i okruženje za crtanje (Drawing). Pune delove (engl. solid parts) konstruišete u okruženju za 
modelovanje, dok tehničke crteže punih delova izrađujete u okruženju za crtanje. Kada želite 
da otvorite novu datoteku delova, iz menija File izaberite stavku New Part File.

File>New Part File

Datoteke sklopova
Datoteka sklopa ima tri radna okruženja: za modelovanje (Model), za scenu (Scene) i za 
crtanje (Drawing). Puni delovi i sklopovi, kao i podsklopovi punih delova, konstruišu se u 
okruženju Model. Izgled sklopa u rasklopljenom stanju (scena) konstruiše se u okruženju 
Scene, a tehnički crteži sklopa – u okruženju Drawing. Novu datoteku sklopa otvarate kom-
andom New iz menija File.

File>New

KORISNIČKO OKRUŽENJE
Korisničko okruženje (engl. user interface) programa Mechanical Desktop veoma liči na 
okruženje AutoCAD-a. Osim uobičajenog skupa komponenata radne površine AutoCAD-
a, u Mechanical Desktopu postoji i  pretraživač – Desktop Browser, prikazan na desnoj stra-
ni slike 1-13.

Slika 1-13 Korisničko okruženje programa Mechanical Desktop

Desktop Browser
Desktop Browser prikazuje objekte konstruisane u različitim radnim okruženjima (za mode-
lovanje, za scenu i za crtanje) i obezbeđuje prečice ka komandama u priručnom (kontekstnom) 
meniju. Za svaki od dva tipa datoteka (delova i sklopova) postoji posebna varijanta Desktop 
Browsera. Za datoteku delova, Desktop Browser ima dve kartice (Model i Drawing), dok za 
datoteku sklopova ima tri kartice (Model, Scene i Drawing).
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Kartica Model prikazuje objekte punog dela ili sastavne delove sklopa. Kartica Scene 
prikazuje objekte u scenama sklopa, a kartica Drawing objekte crteža. Slika 1-13 prikazuje 
pretraživač datoteke sklopa, a slika 1-14 korisničko okruženje datoteke delova. Kada želite da 
nešto radite sa objektom u datoteci, izaberite ga u pretraživaču, pritisnite desni taster miša i iz 
priručnog menija izaberite odgovarajuću komandu (slika 1-15). Ako pretraživač nije na ekra-
nu, izaberite stavku Desktop Browser iz podmenija Display menija View.

View>Display>Desktop Browser

Slika 1-14 Korisničko okruženje datoteke delova

Slika 1-15 Priručni meni u pretraživaču
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Sistem menija
U vrhu ekrana nalazi se 15 menija. Meniji Surface, Part, Assembly i Drawing sadrže četiri glavne 
alatke za projektovanje Mechanical Desktopa. Ako ne vidite ove menije, upišite MENULOAD 
na komandnu  liniju i pritisnite taster Enter. Otvoriće se okvir za dijalog Menu Customization 
(slika 1-16). Pritisnite dugme Browse i izaberite željenu datoteku s menijima (amdtacad.mns). 
U prozoru Select Menu File pritisnite dugme Open, što će vas vratiti u okvir za dijalog Menu 
Customization. Pritisnite dugme Load; ime datoteke će se pojaviti na listi Menu Groups. Pri-
tisnite dugme Close da biste se vratili na radnu površinu (engl. desktop).

Slika 1-16 Okvir za dijalog Menu Customization

Palete alatki
Ispod trake menija (engl. menu bar) nalazi se glavna paleta alatki (engl. toolbar) – Desktop 
Main (prikazana u neusidrenom stanju na slici 1-17). Pošto su programi Mechanical Desk-
top i AutoCAD međusobno integrisani, na paleti su na raspolaganju komande iz oba pro-
grama. Međutim, zbog ograničenog prostora u menijima i prozoru, pored menija i paleti alatki 
Mechanical Desktopa prikazani su samo osnovni meniji komandi AutoCAD-a. Palete alat-
ki su grupisane prema srodnim poslovima (modelovanje dela, modelovanje sklopa, konstruisa-
nje scene i tehničko crtanje). Da biste prikazali paletu alatki Surface Modeling (slika 1-29), iz 
menija Surface izaberite stavku Launch Toolbar. 

Slika 1-17 Glavna paleta alatki – Desktop Main
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Kada hoćete da prikažete palete alatki koje nisu na ekranu, iz podmenija Toolbars meni-
ja View izaberite stavku Customize Toolbars. U okviru za dijalog Customize izaberite karti-
cu Toolbars, a zatim na listi Toolbars unesite znak potvrde u polja pored paleta koje želite da 
prikažete (slika 1-18).

View>Toolbars>Customize Toolbars

Slika 1-18 Kartica Toolbars u okviru za dijalog Customize

Skrivene palete alatki prikazaćete i ako desnim tasterom miša pritisnete bilo koju vidljivu 
paletu alatki i zatim ih izaberete iz priručnog menija.

UNOŠENJE KOMANDI
Kada menije i palete alatki rasporedite po radnoj površini onako kako vam odgovara, koman-
de Mechanical Desktopa možete da izvršavate na više načina:

• Biranjem stavke iz menija

• Pritiskanjem dugmeta na paleti alatki

• Upisivanjem komande na komandnu liniju

• Biranjem iz kontekstnog menija koji se otvara kada desnim tasterom miša pritiskate različite 
delove radne površine

• Pritiskajući dvaput objekat u Desktop Browseru

SLOJEVI
Pri radu u Mechanical Desktopu sretaćete se s više slojeva (engl. layers) čija imena počinju 
na AM. Mechanical Desktop ih koristi iz određenih razloga. Ti slojevi se generišu automat-
ski. Oni sadrže različite objekte, kao što su vidljive linije, skrivene linije, granice rakursa (engl. 
viewport borders) tehničkih crteža konstruisanih od punog dela ili sklopa punih delova. Nemo-
jte im menjati imena.
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ALATKE AUTOCADA 2005
Alatke AutoCAD-a koristite da biste konstruisali krive, neophodne za pravljenje površina i 
punih tela, te da biste napravili zaglavlja i uneli odgovarajuće oznake na tehničke crteže.

MODUL ZA PARAMETARSKO MODELOVANJE PUNIH TELA
Prva generacija modela punih tela izrađenih na računaru bila je najčešće statična, što znači 
da se pun model konstruisan od krivih nije mogao naknadno menjati (dubokim izvlačenjem, 
obrtanjem, i izvlačenjem duž putanja metodama loft i sweep). S pojavom snažnijih računara i 
savršenijih programa za 3D modelovanje, postalo je moguće da se parametri punog tela menjaju 
bilo kad u procesu projektovanja. Prvobitna puna tela – ona statična – obično se označavaju kao 
neparametarska puna tela (engl. non-parametric solids) (AutoCAD-ova puna tela), dok se ona 
druga nazivaju parametarskim punim telima (engl. parametric solids). Parametarska puna tela 
modifikuju se menjanjem vrednosti njihovih mera (engl. dimensions). Zbog toga je i odgovarajući 
sistem modelovanja poznat kao sistem modelovanja parametarskih punih tela na osnovu me-
njanja njihovih mera (engl. dimension-driven parametric solid model system).

Modul za modelovanje delova Mechanical Desktopa jeste sistem za modelovanje parametar-
skih punih delova zasnovan na karakteristikama, tj. elementima (engl. features). Kada želite da 
konstruišete pun model 3D objekta, prvo analizirajte objekat i razložite ga na elemente punog 
tela, a zatim konstruišete elemente jedan po jedan. Pošto je puno telo razloženo na elemente, 
a parametri elemenata se mogu menjati, puno telo se zove parametarsko puno telo zasnovano 
na elementima (engl. parametric feature-based solid).

Kada konstruišete pun element (engl. solid feature), prvo pomoću AutoCAD-ovih alat-
ki napravite grubu skicu (engl. rough sketch). Zatim je pomoću alatki Mechanical Desktopa 
konvertujete (engl. resolve) u parametarsku skicu (engl. parametric sketch) i od nje konstruišete 
pun element. Za složen puni element prvo napravite pojedinačne elemente, a zatim ih povežite 
logičkim operacijama. Na slici 1-19 dat je pun objekat dobijen spajanjem elemenata nasta-
lih pomoću četiri metode – izvlačenjem, obrtanjem, složenim izvlačenjem duž putanje (loft) 
i prostim izvlačenjem duž putanje (sweep). Elementi punog tela koji su konstruisani od skica 
zovu se elementi skiciranog punog tela (engl. sketched solid features).

Slika 1-19 Puno telo sa četiri skicirana elementa: izvučenim (centar), obrtnim (gornji deo), elementom 
dobijenim pomoću metode loft (levi kraj) i elementom dobijenim pomoću metode sweep 
(desni kraj)

Osim elemenata skiciranog punog tela, postoje i gotovi puni elementi (engl. pre-construct-
ed solid features). Dodajete ih modelu tako što ih birate iz menija ili sa paleta i zadajete im 
parametre i položaj. Pošto ih konstruišete tako što ih postavljate u model, to su postavlje-
ni puni elementi (engl. placed solid features), no mi ćemo ih zvati gotovi puni elementi. Na slici  
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1-20 prikazan je pun model sa četiri vrste gotovih punih elemenata (zarubljenje – engl. cham-
fer, zaobljenje – engl. fillet, otvor – engl. hole i školjka – engl. shell).

Slika 1-20 Puno telo sa četiri vrste gotovih punih elemenata (zarubljenje, zaobljenje, otvor i školjka)

Kada konstruišete pun element, koristite i radne elemente (engl. work features) kao geometrij-
ske reference. Prema tome, pun deo može da ima tri vrste punih elemenata: skiciranog tela, 
gotove i radne.

Na slici 1-21 prikazani su meni Part i paleta alatki Part Modeling u programu Mechani-
cal Desktop. Pomoću tog menija i te palete možete da konstruišete parametarske pune delove 
zasnovane na elementima.

Slika 1-21 Meni Part i paleta alatki Part Modeling u programu Mechanical Desktop

Ako ste već radili u AutoCAD-u, verovatno znate da i on ima zbirku alatki za modelova-
nje punih tela. (Pogledajte na slici 1-22 podmeni Solids menija Design.) Za razliku od para-
metarskih alatki, ova zbirka alatki omogućava konstruisanje samo neparametarskih punih tela 
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(tj. AutoCAD-ovih matičnih punih tela). Zapamtite, parametarska puna tela konstruišu se 
alatkama Mechanical Desktopa, a neparametarska puna tela – alatkama AutoCAD-a.

Slika 1-22 Podmeni Solids menija Design

U 2. poglavlju naučićete da konstruišete parametarske skice, a u 3, 4. i 8. poglavlju – kako 
se prave parametarska puna tela.

MODUL ZA MODELOVANJE SKLOPOVA
Modul za modelovanje sklopova (engl. assembly modeling module) predstavlja jedinstven skup 
alatki za okupljanje komponenata u sklop nekog proizvoda ili sistema. Komponente sklopa su, 
u stvari, njegovi pojedinačni sastavni delovi. Međutim, ako radite s proizvodom ili sistemom 
koji imaju veliki broj delova, pogodnije je i praktičnije da delove slažete u manje podsklopove 
(engl. subassemblies) koje kasnije objedinjujete u konačan sklop. Prema tome, komponente sklo-
pa u ovom smislu jesu puni delovi ili podsklopovi.

Konstruisanje sklopa podrazumeva povezivanje zbirke potrebnih komponenata (punih 
delova ili podsklopova), razmeštanje komponenata na odgovarajuće pozicije i uspostavljanje 
odnosa među njima. Sve to postižete primenjujući uslove sklapanja (engl. assembly constraints) 
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na odabrane parove elemenata komponenata. Sklop koristite da biste modelovali čitav proiz-
vod ili sistem, da biste sagledali sklop u celini, proverili eventualno neslaganje komponenata i 
prikazali izgled proizvoda ili sistema u rasklopljenom stanju. Na slici 1-23 prikazani su meni 
Assembly i paleta alatki Assembly Modeling u programu Mechanical Desktop.

Slika 1-23 Meni Assembly i paleta alatki Assembly Modeling u programu Mechanical Desktop

U 5. poglavlju naučićete da od komponenata konstruišete sklopove, a u 6. – kako se prave 
scene (izgled sklopa u rasklopljenom stanju).

MODUL ZA POVRŠINSKO MODELOVANJE
Površinski modeli se najčešće koriste za predstavljanje 3D objekata proizvoljnog oblika (engl. 
free-form objects). Kada želite da napravite površinski model, prvo treba da konstruišete nje-
gov skelet (engl. framework) od 3D krivih. Posle toga zadajete vrstu površine koju računar au-
tomatski generiše.

Modul za površinsko modelovanje je sistem površinskog modelovanja koji radi pomoću 
objekata tipa NURBS (neuniformna racionalna kriva tipa B − engl. Non-Uniform Rational  
B-Spline) i namenjen je projektovanju i proizvodnji. Možete ga upotrebiti za konstruisanje 
površina proizvoljnog oblika (engl. free-form surfaces) (slika 1-24). On obuhvata i skup alat-
ki za konstruisanje i modifikovanje 3D krivih pomoću kojih možete da napravite složen ske-
let kao podlogu za površinu.

Slika 1-24 Površina proizvoljnog oblika
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Modul ostvaruje i vezu između površina i punih tela tako što vam omogućava da:
• površini dodelite debljinu i tako je pretvorite u puno telo sa 3D profilom proizvoljnog oblika

• međusobno povežete (engl. stitch) više „nepropusnih“ površina u jedno puno 3D telo proiz-
voljnog oblika

• površinu upotrebite kao oštricu za prosecanje punog tela

Možete takođe i da povezanu površinu, AutoCAD-ovo matično puno telo ili puno telo na-
pravljeno u Mechanical Desktopu pretvorite u skup NURBS površina (slike 1-25 do 1-28).

Slika 1-25 Puno telo konstruisano tako što je površini dodeljena debljina

Slika 1-26 Prikaz odozgo punog modela automobilske školjke konstruisanog od skupa povezanih 
površina

Slika 1-27 Puno telo presečeno površinom
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Slika 1-28 Puno telo pretvoreno u skup površina

Na slici 1-29 prikazani su meni Surface i paleta alatki Surface Modeling u programu Me-
chanical Desktop. Nemojte ih mešati sa AutoCAD-ovim alatkama za površine (iz podmenija 
Surfaces menija Design i s palete alatki Surfaces) koje su prikazane na slici 1-30. 

Slika 1-29 Meni Surfaces i paleta alatki Surface Modeling u programu Mechanical Desktop

Slika 1-30 Podmeni Surfaces menija Design i paleta alatki Surfaces u AutoCAD-u
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Alatke za rad s površinama u AutoCAD-u znatno su jednostavnije – one definišu površinu 
kao poligonalnu mrežu (engl. polygon mesh). Svaka složena glatka površina predstavlja se 
mrežom sastavljenom od poligonalnih faseta (engl. polygonal face) i krivolinijskih ivica 
izgrađenih od pravolinijskih segmenata. Na slici 1-31 prikazan je skup površinskih mreža  
(engl. surface meshes) koje samo približno predstavljaju prvobitne površine. Nasuprot tome, 
površine koje konstruišete alatkama programa Mechanical Desktop, predstavljaju glatke, 
neprekidne površine, tako da možete dobiti tačne koordinate svake tačke površine. Kako se 
prave površinski modeli naučićete u 7. poglavlju.

Slika 1-31 Površine predstavljene poligonalnim mrežama, dobijene alatkama za rad s površinama  
u AutoCAD-u

MODUL ZA TEHNIČKO CRTANJE
Modul za crtanje i označavanje (engl. drawing and annotation module) (zvan i modul za tehničko 
crtanje) generiše tehničke 2D crteže međusobno povezanih prikaza površina, punih tela i sklo-
pova, i omogućava da generisane crteže označite na odgovarajući način. Pošto konstruišete 3D 
model, generisanje tehničkih crteža ide poluautomatski. Pomoću modula za crtanje treba da 
zadate samo prikaze i njihovu razmeru (engl. scale), a računar ostalo radi sam. Pošto napravite 
crteže kakve želite, možete u njih uneti odgovarajuće oznake (engl. annotations). Na slika-
ma 1-32 i 1-33 prikazani su meniji Drawing i Annotate, i paleta alatki Drawing Layout pro-
grama Mechanical Desktop. U 9. poglavlju naučićete da pravite tehničke crteže punih delova 
i površina, a u 10. poglavlju – tehničke crteže sklopova.
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Slika 1-32 Meni Drawing i paleta alatki Drawing Layout programa Mechanical Desktop

Slika 1-33 Meni Annotate
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KOMPATIBILNOST I SARADNJA SA AUTOCADOM
Naglasimo još jednom, Mechanical Desktop 2005 je nadogradnja AutoCAD-a 2005 i kori-
sti datoteke njegovog matičnog formata (DWG). Prema tome, puna tela i površine izrađeni u 
Mechanical Desktopu i AutoCAD-ova matična puna tela potpuno su međusobno kompati-
bilni. Možete ih kombinovati bez ograničenja.

AutoCAD-ova matična puna tela
AutoCAD-ovo matično puno telo (engl. native solid) možete da pretvorite u osnovni element 
punog tela (engl. base solid feature) u Mechanical Desktopu, kome možete da dodajete druge 
parametarske pune elemente. Isto tako, fasete AutoCAD-ovog matičnog punog tela možete 
da pretvorite u skup NURBS površina.

Površine Mechanical Desktopa
U Mechanical Desktopu možete da više nepropusnih površina povežete u jedinstveno puno 
telo. Pomoću NURBS površine kao površinskog elementa, možete da prosečete dobijeno puno 
telo ili matično telo AutoCAD-a.

Parametarska puna tela Mechanical Desktopa
Parametarsko puno telo napravljeno u Mechanical Desktopu možete da pretvorite u AutoCAD-
-ovo matično puno telo. Parametarsko telo možete i da pretvorite u skup NURBS površina.

OPCIJE
Podešavanja u okviru za dijalog Options određuju način rada sistema i ono što vidite na ekra-
nu (slika 1-34).

Izaberite Assist>Options

Slika 1-34 Okvir za dijalog Options

Okvir za dijalog Options ima više kartica koje se odnose na različite poslove. Počnimo, 
na primer, od kartice User Preferences. Ovde, između ostalog, treba da budu izabrane opci-
je Synchronize Browser with Modes i Synchronize Toolbars with Modes. Kada ih izaberete, 
pretraživač i palete alatki sinhronizovaće se s radnim okruženjem (Model, Scene i Drawing). 
Okvir za dijalog zatvarate pritiskajući dugme OK.
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PITANJA ZA PROVERU ZNANJA

1. Navedite tri vrste 3D modela i ukratko opišite njihove osobine.

2. Navedite četiri modula (alatke) Mechanical Desktopa i opišite njihove glavne funkcije.

3. Na koliko načina možete da izvršite komandu Mechanical Desktopa? Navedite ih.

4. Kako ćete modelovati proizvod ili sistem koji se sastoji od više komponenata?

5. Kako ćete napraviti tehnički crtež 3D modela?

SAŽETAK

Osnovni cilj korišćenja računarskog modela jeste tačno predstavljanje 3D objekta u raču-
naru. Postoje tri vrste računarskih modela (žičani, površinski i pun model). Pun model 
sadrži najviše podataka o objektu i najpogodniji je za kasniju primenu u proizvodnji. 
Površinski modeli bolje predstavljaju složene 3D objekte proizvoljnog oblika. Prema tome, 
metode modelovanja pomoću punog tela (izvlačenje, obrtanje, loft i sweep) primenićete 
na 3D objekte pravilnih oblika, a metode površinskog modelovanja – na složene objekte 
proizvoljnog oblika. Ako vam treba pun model objekta složenog oblika, pretvorite njegov 
hermetički zatvoren površinski model u pun model. Žičani modeli imaju ograničenu 
primenu u računarskom modelovanju. Ipak, ponekad treba da napravite žičani skelet kao 
podlogu za površinski ili pun model.

Mechanical Desktop 2005 je programska alatka za inženjersko projektovanje koja se 
izvršava u AutoCAD-u 2005. Program sadrži četiri modula: za modelovanje parametarskih 
punih tela, za modelovanje sklopova, za površinsko modelovanje i za tehničko crtanje.

Pomoću modula za modelovanje parametarskih punih tela možete da konstruišete para-
metarske pune delove zasnovane na elementima. Puna tela se konstruišu od grubih skica  
i gotovih elemenata, i mogu se podešavati. U puno telo mogu se uključiti i površine.

Modul za modelovanje sklopova omogućava da konstruišete sklop komponenata – punih 
delova ili podsklopova punih delova. Pomoću njega možete i da prikažete sklop u rasklop-
ljenom stanju.

Pomoću modula za površinsko modelovanje možete da konstruišete površine proizvoljnih 
oblika i da ih upotrebite za pravljenje punih delova.

Pomoću modula za inženjersko crtanje možete da izradite tehničke crteže punih tela, 
sklopova i površina.

Korisničko okruženje Mechanical Desktopa veoma liči na okruženje AutoCAD-a, uz neko-
liko bitnih razlika. U njemu postoje dodatne stavke u menijima, neki meniji su preuređeni, 
a tu je i pretraživač – Desktop Browser – koji prikazuje objekte iz datoteke delova ili 
datoteke sklopova i obezbeđuje prečice ka komandama.


